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Introduction 
About this unit 
The unit takes you through the processes for creating, saving and printing a document.  You will 
also learn to format and edit a document.  By preparing a lesson plan using the word processor, 
you will apply all of these new skills. 

As well as information about the word processing functions, this manual will include practical 
activities for you to complete.  All activities will be clearly identified and give you an 
opportunity to practice the new functions.  If needed, additional worksheets activities are 
supplied at the end of Section 5 to allow you to do extra practice. These activities do not play a 
part in your assessment for this unit.  They are there to help you check your learning progress. 
 
Only basic commands are used in this module.  In Word 2000 there are many ways of doing the 
same function.  While we have not identified the full list of options, we have discussed several 
methods for some of the functions.  You can choose the method that best suits you. 
 
Check to ensure that you have the following before starting: 
• Access to a computer with Microsoft Word 2000 software 
• Unit 10.4 learning materials (this manual) 
• Student activity disk—supplied with this manual containing the following files: 

 
- PLAN TRAINING 
- SPELL 
 

Contact your tutor if these resources are not available or to discuss the issues outlined 
above. 
 
How you’ll be assessed 
The assessment will be a practical use of the word processor to: 
• Create, using a word processing package and in accordance with given information, a basic 

document. 
• Edit the created document in accordance with given instructions and including the shifting of 

paragraphs, use of bold and italic type styles, and different typefaces and font styles. 
• Save the document, without error and using the name given, to a new specified folder. 
• Print one copy of the document, without error and in accordance with given instruction. 
• Prepare a lesson plan, using a given word processing package, for a specific area of expertise. 
 
Recognition of prior learning is encouraged.  If you feel confident you have the necessary level 
of competence to successfully complete the elements listed above, you may be able to take the 
assessment without studying the unit. 
 
Get in touch with your tutor when you are ready for assessment. 
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Section 1 – Introduction to Microsoft Word 
 

 
 

 
What is Microsoft Word 2000 

There are many word processing packages/programs available that allow you to produce 
professional looking documents.  One of the most widely used is Microsoft Word produced by 
the Microsoft Corporation.  Even with Microsoft Word, there are a number of versions (e.g. 
Word 6 and Word 97).  Each newer version of Word incorporates enhanced features over the 
older versions.  For the purpose of this manual, our references will be made to Word 2000.   

You will find that you can apply the basic skills you will learn about Microsoft Word 2000 to 
any of the other Windows word processing applications on the market. 

Getting Started 
 
To start Word 2000 click Start, point to Programs on  the start menu, then click Microsoft 
Word in the Programs submenu. Microsoft Word will launch, displaying the version of Word 
you are using. 
 

 

Programs 

 
Start 
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The Microsoft Office 2000 Toolbar 
 
If the Microsoft Office 2000 toolbar is visible, you may start Word 2000 by clicking on the 
Word 2000 button on the toolbar. 
 

Microsoft Office 
2000 Toolbar 

 
 
 

 
 
 
 
 
The Word 2000 W
 
When you start Word 2000, 
blank document like the one
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Activity 1 

Starting Word 

1. Start Word 2000 from the Programs menu or by clicking on the Word 2000 icon on the 
Microsoft Office 2000 toolbar. 

2. On your screen locate the parts of the Word screen identified on the previous page. 

o Title Bar.   This contains the program name—Microsoft Word – Document 1.  The default 
name Document 1 will remain until you save the document with a name of your choosing. 

o Menu Bar.   Located below the Title bar.  This special toolbar displays pull-down menus that 
contain commands for performing tasks in Word 2000.   

o Toolbars.   These contain short icons for performing the most executed tasks. Different 
toolbars can be opened at various stages. 

o Ruler.   The (horizontal) ruler identifies the left and right margin settings, tab and indent 
settings, column and table settings, etc.  A vertical ruler sometimes displays when you are 
completing certain tasks. 

o Status Bar.   This shows information such as the number of pages in the document and current 
position of the insertion point in a document. 

o Scroll Bars.   Vertical and horizontal scroll bars are used to bring unseen portions of a 
document into view. 

o Work area.  When you enter text it will be displayed in the work area. 

o Mouse pointer.   The mouse pointer is represented as an I-beam    over the work area. 

o Selection bar.   When the mouse is moved to the left side of text (i.e. in the margin) in the 
document, it changes to a right-pointing arrow  . 

o Insertion point.   The blinking vertical bar in the document shows the position at which text 
will be inserted. As you type, the insertion point moves to the right.  When you have the end of 
your line, the insertion point moves to the beginning of the next line. 

o View buttons.  The four views give you choices as to display your document on the screen. 

o Paragraph mark.  The paragraph mark ¶ is inserted when you press ENTER to indicate the 
end of a paragraph.  You will only see this symbol if you have selected the Show/Hide button 

on the toolbar  . 
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The Keyboard 
As you type, do not press too heavily on the keys, as some keyboards are fairly sensitive and you 
may find that a character might be repeated.  If this happens, simply Backspace to delete the 
additional characters. 

The special keys that are most often used are show below with their functions.  Find each key on 
your keyboard before proceeding. 

Key Function 
Enter Adds a new line to your document directly under the line you are on.
Backspace Deletes the character to the left of insertion point. 
Delete Deletes the character to the right of insertion point. 
Shift This key is used in conjunction with other keys.  With letters, it 

produces a capital letter corresponding to the letter depressed.  With 
numbers and symbols, it produces the top character on the key 
depressed. 

Caps Lock When turned on, capital letters will be produced when letter keys are 
depressed.  An indicator light (usually above the numeric pad) 
indicates when the Caps Lock is turn on. 

Tab Moves to a preset position in a document. 
Home Moves the insertion point to the beginning of the line. 
End Moves the insertion point to the end of the line. 
 Moves the insertion point to right on a line. 
 Moves the insertion point to the left on a line. 
 Moves the insertion point up one line. 
 Moves the insertion point down one line. 

 

Spacing between words 
Space once between words, using the Space Bar.  Traditionally, typists spaced twice after a 
period to begin a new sentence, although some sources would say to space once.  If you are in 
the habit of spacing twice after a period, you may continue that method of spacing.  Whichever 
method you use, make sure you are consistent throughout your document. 

Toolbars in Word 
Toolbars offer shortcut buttons, boxes and menus to enable you to perform many Word tasks 
quicker than using the menus on the menu bar.  For example, when you want to center text, you 
can click Format on the Menu bar, click Paragraph and then select Center from the drop down 
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menu under Alignment, or you can simply click on the Center button  on the Standard 
toolbar. 

As you work through this manual, some of the activities will require you to use options from the 
Standard or the Formatting toolbar.  Ensure that both of these toolbars are always visible (they 
are usually displayed under the menu bar).   

Formatting toolbar:  
 

 
Standard toolbar:  
 

 

If a toolbar button is not visible, click the double arrow at the end of the toolbar it 
The double arrows indicate that some of the buttons on that particular toolbar are n
Otherwise, you may have to click the down arrow at the end of the toolbar and Ad
the toolbar. 

If one of these toolbars is not visible as you work through the activities, click on th
then Toolbar, and select the toolbar (Standard or Formatting) you want to have ac
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Section 2 – Creating a New Document 
 

 
 

 
What is a Document 

A file created using word processing software is called a document.  This includes items such as 
letters, memos, lesson plans and reports.  There are several ways to create a new Word 
document: 

• Select the New Blank Document button  on the Standard toolbar 
• Click File on the Menu bar, and then click New.   Double-click the New Document option 

from the New dialog box.  
• Press Ctrl+N on the keyboard and then double-click the New Document option from the 

New dialog box. 
Any of these actions will produce a new blank document window. 
 

Entering Text 
To enter text into a document, type on the keyboard.  The text will appear where the insertion 
point is on the screen.  As you type, the insertion point moves to the right of the text.  When you 
want to enter a blank line into your document, press the Enter key without typing any line of 
text. 

Word-wrap  

When you reach the end of a line as you type, you do not have to press the Enter key to go to the 
next line. Word automatically positions the insertion point on the next line when it reaches the 
right margin. Therefore, you do not have to worry about where lines end.    This function is 
called word wrap.   

Press the Enter key only when you want to start a new paragraph, to insert a blank line in your 
document and in response to certain Word commands.  

 

 
 

 
Quick Spell checking 

Word has an automatic spelling and grammar checking feature.  Word alerts you to a possible 
spelling error as you type by flagging any word that is not in its dictionary.  A red wave line is 
placed underneath the possible misspelling.  Similarly, if your typing contains possible grammar 
errors, Word flags the error will a green wavy line.  These lines will not appear when you print 
your document. 
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Although you can use the Spelling and Grammar checking feature on the Tools menu to check 
the entire document for spelling and grammar errors, Word allows you to check these flagged 
errors immediately. 

To make a correction to a misspelled word or grammatical error: 

Spell It shortcut menu 
 

1. Right-click on the flagged word. 

2. Word displays the Spell It short cut menu, like the one to the 
right, which lists suggestions for the correct spelling of the 
word. 

3. You can: 

a. Click on the correct spelling if it appears in the list. 

b. Choose to ignore the word (or any instance of the word 
appearing in the document spelt the way it is) by clicking 
on Ignore All 

c. Add the word to your custom dictionary—which is a good 
idea especially with names you will use a lot.  This way, 
Word will not flag the word again. 

If the word is misspelt, but the correct spelling is not displayed, select the word (the Spell It 
menu will disappear) and correct the spelling.   

To ensure the accuracy of your document, prior to printing, it should be checked for spelling 
errors before you print it. 

Word also notes any instances where you may have held the Shift key in error and have what is 
referred to as ‘irregular case’, i.e. a mixture of upper and lower case letters (e.g. WOrd, 
WinDows). 

Word will check for misspelt words, as well as words which are repeated (e.g. the the).  Always 
read the context of the sentence before correcting it, because in some instances the double word 
may not be an error, e.g. ‘He had had problems before.’ 

AutoCorrect 
Word is set to automatically correct some commonly misspelt words.  For example, if you type 
the word “teh”, Word will automatically correct this word to “the” when you press the Spacebar 
or type a punctuation mark.  To see a complete list of the words that are automatically corrected 
by Word, click Tools on the Menu bar, click Autocorrect, click the AutoCorrect tab and then 
scroll down the list of words near the bottom of the dialog box. 
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Using the Undo and Redo Functions 

The last 100 operations that you perform in Word are stored in a temporary memory area so that 
Word can reverse them, if required. 

Undo Function 

Use the Undo button  on the Standard toolbar to undo the last change you made to your 
document.   

By clicking on the down arrow to the right of the Undo button, you will see a list of the previous 
document actions.  You can highlight a number of these actions to undo that many changes.  In 
the example below, five of the last actions are highlighted.  Therefore, Word will undo the last 
five actions simultaneously. 

 

down arrow

scroll box to scroll 
through the changes 

made in the document 
Status bar to 
indicate how 

many action are 
selection to be 

undone.  

Redo function 

If you want to reverse the change that resulted from using the Undo button, click the Redo  
button on the Standard Toolbar. 

 

 
 

 
Saving a Document 

As you type, Word stores the document in memory.  If the power to the computer is interrupted, 
the document in memory is lost.  Saving a document stores the document on a disk.  The 
document can be retrieved at a later date to be edited, printed or saved to another disk. 
 
When you save a document for the first time in Word you may choose the Save or the Save As 
command.   
 
The Save command can be accessed through any of the following:  

• Click File and then Save,  
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• Press Ctrl+S on the keyboard  
• Click the Save button  on the Standard Toolbar. 

 
The Save As command can be accessed by clicking File then Save As. 
In both cases, Word automatically pulls up the Save As dialog box, displayed below.   
 

 

Down arrowSave in box 

File name 
text box Save button

 
After the Save As dialog box appears: 
1. Use the down arrow in the Save in box, and select the Drive and/or Folder where you want 

the document to be saved.  (You may choose to save your document in one of the commonly 
used folders displayed on the left of the Save As dialog box). 

2. Give your file a name by typing it in the File name text box.  (Remember to adhere to the file 
name restrictions you learned about in File Management under Unit 3).  

3. You are ready to save your document.  Click the Save button. 
(Ignore the Save as type box for now, but as you get more proficient with Word, you can save 
your document as another version of Word, or in other formats.) 
 
Your document is now stored on the disk and in the folder you directed it to.   When you modify 
a document after it has been save initially, use the Save command to update the changes made to 
the document.  When a document has been previously saved, only use the Save As command to 
save the document to a new location (like on a another disk), or to save the document using a 
new name. 
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Activity 2  
 

Creating and Saving a document 
 

Let’s try our first document.  The text you are to actually type is shown in the shaded boxes. 

Remember: If you make a mistake, backspace to take it out and retype, or simply leave the 
mistake.  You can focus later on correcting errors in your document.   
1. Type the paragraphs in the shaded box below.  Press Enter twice at the end of each of the two 

paragraphs.  Let the program word-wrap the text in the paragraphs. As you type, practice using 
the Undo and Redo buttons on the Standard toolbar. 

If we talk about someone being a “competent teacher”, we usually mean someone who is 
recognised as being able to do his or her job.  It’s that and a bit more.  It also means that we 
recognise that person is able to perform the job to a certain standard. 

The idea of competence is one of the most important concepts in competency-based training. 
2. Add the following to the end of the document.  Press the Tab key before entering the definition.  

Do not use the space bar to align text.  It may be necessary to press the Tab twice in the third 
line to align the text under the p. 

 
COMPETENT PERFORMANCE 
 
Plan activities that will allow you to check the learner can perform, demonstrate and apply. 
 
Word  Definition 
 
perform   to the required standard 
demonstrate   required attitudes 
apply  important pieces of knowledge 
 
3. Save the document on a floppy disk or on your hard drive.  Name the file COMPETENCE.  
 Ensure you save the document in a location where you can find it later. 
  
 Leave the file open to use in the next activity. 
 

 

Moving through a document 
To move the insertion point to a new position in your document, do any of the following: 

• Using the mouse pointer, that is now displayed as the I-beam, click the I-beam where you 
want the insertion point to be. 

• Drag the scroll box along the scroll bars to move up and down or left and right in your 
document. 
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• Use the arrow keys, as indicated in the Keyboard table on page 7, to navigate one character 
or one line in any direction in your document. 

• Use the Page Up and Page Down button to move up one screen or down one screen 
respectively. 

Using the keyboard to move around your document 

The table on the next page provides keystrokes to assist in moving throughout the document. 

Keystroke Moves to: 

Ctrl + Home Beginning of document 

Ctrl + End End of document 

Ctrl +  Next word 

Ctrl +  Previous word 

Ctrl +  Previous paragraph 

Ctrl +  Next paragraph 
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Activity 3 
 
Moving around a document 
 

Let’s practice the following using the file (COMPETENCE) you have open on screen 
 
1. Move the insertion point to the following locations: 
 

• bottom of document; 

• up one paragraph;  

• top of document; 

• down one paragraph; 

• end of line; 

• beginning of line; 

• word right; 

• word right three, i.e. hold down Ctrl key while pressing → three times 

• word left; 

• word left two; 

• down three paragraphs; 

• up two paragraphs; 

• end of document. 

 
2. Let’s add some text to the end of the document.  Check your insertion point is at the end of 

the document. 
• Type your name.  Enter twice.  
• Type the current date. 

 
3. Save the changes you made to the file. 
 

 
Selecting Text 
In order to perform particular tasks on texts in Word, you must first select the text you want to 
work with.  Selected text appears highlighted on your screen.  You can select text by clicking at 
the beginning or end of the text you want highlighted, hold down the left mouse button, and 
dragging until the text you want to select is highlight. The following table outlines ways of 
selecting text. 
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To Select: Perform this task: 

A word Double-click anywhere on the word. 

A sentence Hold down the Ctrl key and click anywhere in the sentence. 

A paragraph Triple-click anywhere in the paragraph. 

The entire 
document 

On the Edit Menu, select the Select All option, or hold down the Ctrl key, 
then press A on the keyboard. 

Multiple words, 
lines or sentences 

Click so that the insertion point is at the beginning of the text you want 
highlighted.  Move the I-beam to when the text you want selected ends, hold 
down the Shift key, then click.  Everything between the two clicks will be 
selected. 

 

 

 
 

 
Activity 4 
 
Using highlighting techniques 
 

Let’s practice these highlighting techniques using the file that you created and saved 
(COMPETENCE). 
 
1. Highlight the following Words (one at a time) in your document: 

• Talk 

• Recognise 

• Standard 

• Apply 

 Remember: Click anywhere else in the document to remove highlighting or press any arrow key. 

2. Highlight the sentence that starts “Its that…” by holding down the Ctrl key and clicking anywhere 
in the sentence. 

3. Highlight the second paragraph by triple-clicking anywhere in the paragraph. 

4. Highlight the three words (“perform”, “demonstrate” and “apply”) and their definitions. 
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View modes 

Word 2000 offers four ways to view (display) your document on the screen as you are working 
with it.  The different views can be accessed from the View drop down menu on the Menu 
Toolbar, or by selecting one of the view buttons displayed at the left of the horizontal Scroll bar. 

                

View drop 
down menu 

 
s

The Normal View allows you to quickly 
display margins or page numbers. 

The Web Layout View displays the docu
view is useful when using Word 2000 to c

The Print Layout View displays the docu
displays margins and page numbers. 

The Outline View helps you review and w
expand or collapse your document in this
without the text you have under the headi
with long documents. 

If you point to each view’s button, the nam
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Activity 5 
 
Viewing your document 
 

1. The document Competence should be opened on the screen. 
 Click on the icon for Page Layout View.  
 
2. Click on the icon, Normal View.  Note the difference in the screen display. 
 
Note:   In Page Layout View, the vertical scroll bar has two additional buttons located at the bottom.  
These two buttons allow you to Page up and Page down quickly.  You will notice that as you use 
these buttons, the Insertion Point remains at the same vertical position on the previous or next page. 
 

 

From now on you may work in whichever View Mode suits you.  As you work through Word 
2000, some features will not display in Normal View, and the system will ask you to change to 
Page Layout View. 
 

 

 
 

 
Print Preview   

It is possible to see how your document will look when printed before actually printing the 
document.  You can then confirm that the document will print the way you want it to, thus 
saving time and paper.  

To use Print Preview, either: 

1. Click File, then Print Preview 

 or 

2. Click the Print Preview button on the Standard toolbar. 

The Print Preview window appears. 
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Print Preview Close button

Magnifier 

Status bar 

• The word Preview is displayed next to the name of the document, in parenthesis. 

• The Status bar indicates which page in the document is displayed, the section and how many 
pages are in the document. 

The Print Preview toolbar 

 

Note the function of each button on the Print Preview tool bar. 

Button Function 

Print   
Prints the document from Print Preview. 

Magnifier  
When activated, you may click in the document to zoom in and out.  
When deactivated, you may edit the document. 

One page  
Displays one page of the document at a time in the window. 
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Multiple page  
Drag through this grid to select the number of pages to view in the 
window at a time. 

Zoom  Enter a number in this box, or select one using the drop down arrow, 
to reduce or enlarge the way the active window is displayed.  The 
percentage can be any number from 10 to 400. 

View ruler  
Displays or hides the rulers. 

Shrink to fit  
Reduces the number of pages in a document by one, i.e. if only a few 
lines are printed on the last page of a short document, Word 
condense the document to fit on one less page by reducing the size 
of the font. 

Full screen  
Hides most of the Print Prevent items so that you can see more of 
you document.  Press Esc or the Full Screen button again to return to 
the previous view. 

Close  Closes Print Preview and returns to the document screen. 

Context-Sensitive Help 

  

Click Help and click any other button within the Print Preview 
window to learn more about that button. 

 

 

 
 

 
Activity 6 
 
Previewing your document 
 

1.   Click on the Print Preview icon to preview the current document—Competence 
 
2. Move your mouse in the print preview page.  Ensure that the Magnifier button is activated. Note 

the magnifying glass has a plus (+) sign in the center.  Click the mouse to zoom in on a section of 
text. 

 
 Note now that the magnifier has a minus (–) sign added.  Click the mouse to zoom out. 
 
3. Now turn the magnifier off by clicking on the icon.  Return your mouse over the text and note 

that you have an Insertion Point added to the text of the document.  Turn the magnifier back on. 
 
4. View two pages at a time.  Select the Multiple Pages icon.  As this document is only a one-page 

document, you will notice that the size of the page reduces and moves to various positions on the 
screen as you select different options from the Multipage Icon menu. 

 
5. View one page. 
 
6. Turn the ruler bar off and then on again using the View Ruler icon. 
 
7. Close Print Preview. 
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Printing a document 

Printing in Word produces a paper copy (called a hard copy) of the document displayed on your 
screen.  In order to print a document, a printer must be installed and connected to the computer.   

Before you print your document, made sure the printer is turned on and that there is sufficient 
paper in the paper tray.  Also, check to ensure that the type of paper you are using is compatible 
with the type of printer (inkjet, laser or dot matrix) you are using.  Ensuring that you are using 
the correct type of paper for your printer gives you a better quality of print out.  The information 
on the type of printer the paper you are using is best suited for should be displayed on the 
package. 

When the Print command is issued, a copy of the document held in memory is sent to the printer.  
You should practice saving the document before sending it to print because you can encounter 
printing problems and lose any unsaved work. 

There are several ways to send a copy of a file to the printer.  Two are outlined below for you: 

1. Click anywhere in the document you want to print. 

2. Click on File, then Print. 

3. Hold down the Ctrl button as you press the P key once.   

The Print dialog box will display. 
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Name 
box 

Number of 
copies  

Page 
range 

Collate 
check box

• Since you can have numerous printers installed on your computer, ensure that the printer you 
are printing to is visible in the Name box.  If this is not the case, select the name of the 
printer by clicking the down arrow in the Name box and selecting the correct printer. 

• Chose to print some, all or a portion of a page by selecting the correct option in the Print 
range box.  
o Selecting All prints all the pages in your document.   
o Selecting Current page prints only the page your insertion point is on in the document. 
o Selecting Pages prints the pages you specify in the Pages box.  
o If you choose to print only some of the text in the document, by selecting the text you 

want to print, the Selection will be active.  You can chose Selection to print only the 
portions of the document you highlighted. 

 
• In the Copies box, specify how many copies you want the printer to produce by typing the 

number in the Number of copies box.  You may also use the arrows in the Number of copies 
box to increase decrease the number of copies you want printed. 
o If your document has more than one page, and you want the computer to collate the 

copies for you (e.g. print pages 1, 2, 3 for each copy specified, instead of copying all the 
page 1, then all the page 2, and so on), ensure that there is a check mark in the Collate 
box. 

 

• Click OK to print the document as you specified, or Cancel to cancel the print job. 
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N.B. If you want to quickly print the entire document, click the print button  on the Standard 
toolbar.  The Print dialog box will not open, and the default printer setting will be used to 
print your document. 

 
 

 
 

 
Activity 7 
 
Printing a document 
 

Let’s print a copy of the document we have saved. 
 
1. Print a copy of the file on screen—COMPETENCE 
 

 
 

 
 

 
Exiting Word 

It is important to exit a program when you are finished working in it.  When a file is closed, it is 
removed from the screen and the computer’s memory. If it has been saved before you exited, the 
file will be stored on a disk. 

To exit Word: 

1. Click File 

2. Click Exit. 

If you have not saved a document, Word prompts you to save your file before exiting.  If you 
want to continue in Word, but only want to close the particular file you are working with, choose 
Close from the File menu, or click the Close button on the Title bar. 
 
 

 
 

 
Activity 8 
 
Exiting Word 
 

1. Choose File, Close to close Word or click the close box. If the dialog box appears asking if you 
want to save the changes you made to “Competence” choose Yes to save any changes you made 
to the document.  

 
2. Choose File, Exit to close the Word program or click the close box. 
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Section 3 – Opening an Existing Document 
 

 
 

 
Opening existing files 

Before any changes can be made to a saved Word document, it will have to be retrieved from the 
disk it is saved on.  When you open a Word document, a copy of the document is loaded from 
the disk into the computer’s memory and will display on the screen in the Word window. 

Your operating system gives you different ways to open a file.  We will look at a few of these 
options. 

Using Open on the File Menu 

1. Start Word. 

2. Click File on the Menu Bar, then click Open (or click the Open  shortcut command on the 
Standard toolbar).  The open dialog box will display. 
Look 
in 

box 
 

Open 
Button

3. If you want to open a document that was saved in a different folder, you can search for it. 
Click the down arrow next to the Look in box to locate the file. 

4. Click the name of the document you want to open. 
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5. Click the Open button. 

Word will display the document in the Word window.   

 

Using My Computer  

If the file is stored on a floppy disk, or on your computer disk: 

1. Click My Computer. 

2. Double-click on the disk where the file is located to open the disk. 

3. Locate and open the folder where the file is located. 

4. Double-click the document you want to open. 

The document will open in the Word window. 

 

Using the Open Office Document Command 

1. Click the Start button on the taskbar. 

2. Click on the Open Office Document command on the Start menu. 

3. In the Look in box, locate the file you want to open. 

4. Click to highlight the name of the document you want to open. 

5. Click the Open button. 

 

 
 

 
Activity 9 
 
Opening a document 
 

Let’s open the first file that we saved. 
 
1. Open the file, Competence stored on your disk.   
2. At the bottom of the page, type the name of the school you are currently teaching at. 
3. Save the changes you made to the document 
4. Close the document. 
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Section 4 – Formatting Text 
 
 

 
 

 
Formatting text 

You can enhance the appearance of your text by applying various formatting features to improve 
the appearance of text.  Some features include formatting text as italics, underline, or bold, 
changing margins and line spacing, and working with various font styles and sizes. 

These features can be divided into three groups: 

• Characters—changing the style of characters in a document, e.g. bold, italics, style and size 
of font. 

• Paragraphs—changing the layout of paragraphs of text, e.g. centering, indenting. 

• Sections—changing the layout of a whole page or section of a document, e.g. paper size, 
margins. 

Character formatting 

Bold, italics, underline 

Use the Formatting toolbar to access these features quickly. 

 

d  

 

To apply these formatting
 
Either (after the text is typ
 
1. Highlight (select) the 

2. Click on the formattin
these formatting styles

or (before the text is typed

1. Click on the correspon
about to type. 

2. Type the text. 
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3. Click on the buttons again to turn the formatting off. 

If you want to use keystrokes to apply the formatting for bold, italics and underline, instead of 
clicking the button on the Standard toolbar, do the following: 

 
• Ctrl+B to turn bold on and off. 

• Ctrl+I to turn italic on and off. 

• Ctrl+U to turn underline on and off.  

 

 
 

 
Activity 10 
 
Formatting text 
 

Let’s create a new document. 
 
1. Click on the New Blank Document button. 
 
2. Type the following using the highlighting features as shown in the following example: 
 
PREPARING A TRAINING SESSION 

LEARNING OUTCOMES 

First word should be a ‘DOING’ word 

 List 
 Explain 
 Create 
 Operate 
 Drive 
   Cut 
   Cook 

Remember, it must be an action that can be measured 

 

 
3. Save the document as OUTCOME. 
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Fonts 

You can use various fonts to enhance the look of your document.  Do not use too many different 
fonts.  Two fonts are usually sufficient.  Too many fonts can detract from the appearance of a 
document. 

Font style.   Font or typeface refers to the style/shape of the characters.  Two of the most 
popular fonts are Times New Roman and Arial.     

Height or size of font.   Font size is usually measured in point sizes.  One point is about 0.035 
cm or 1/72 of an inch.  Note the different sizes of the Times New Roman font: 

8 point 

12 point 

24 point 
36 point 
 

 Font size box 

 

To change the font of text: 

After the text is typed: 
 

1. Highlight (select) the text you want to change.

2. Click the down arrow in the font box on the St

3. View the fonts by scrolling down the list. 

4. Click the font you want. 
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The selected text changes to the new font.  

Before the text is typed: 

1. Click the font down arrow on the Standard toolbar. 

2. View the fonts by scrolling down the list. 

3. Click the font you want. 

In the font drop down menu, the names of the font displays the way the font looks. 

To change size of text: 

After the text is typed: 

1. Highlight (select) the text you want to change. 

2. Click the down arrow in the font size box on the Standard toolbar. 

3. Click a font size, or type in the font size you want and press Enter.  

The selected text changes to the new font size.  To deselect the text, click outside the selected 
area. 

Before the text is typed: 

1. Click the font size down arrow on the Standard toolbar. 

2. View the font sizes by scrolling down the list, or type in the font size you want and 
press enter. 

The text you type will now be in the new size. 
 

To change text color: 

 

Font Color button

Color palette 

After the text is typed: 

1. Highlight (select) the text you want to change. 

2. Click the down arrow in the font color box on the Standard toolbar. 

3. Click a color from the color palette to select it.  

The selected text changes to the new color.   

Before the text is typed: 

1. Click the down arrow in the font color box on the Standard toolbar. 

Unit 10.4 - Word Processing 1       Page      29



The Commonwealth of Learning          Module 10 – Applied Computer Studies 

2. Click a color from the color palette to select it.  

The text you type will now be in the new color. 

 

 

 
 

 
Activity 11 
 
Using font styles and sizes 
 

1. Open the document OUTCOME.  Add the following at the end of the document.  Use the font 
styles, color and sizes indicated at the left and apply bold, italic and underline where indicated.  

 
 
Don’t use     
 
learn, know     
be aware of    
understand    
be able to     
 
2. Save and close the document. 
 

Brush Script, 18, 
text color - green

Arial, 14, bold, 
italic, underline

Comic Sans MS, 
12, italic, blue 
text 

 
 

 
 

 
Aligning Paragraphs 

The text alignment controls how the text flows on a page. The four types of alignment in Word 
are left, right, center and justify.  

 

 

JustifyCenter

Align RightAlign Left 

You can quickly set the alignment for a paragraph by clicking one of the four alignment buttons 
from the Formatting toolbar. 

Align Left – All the lines of the paragraph start in the same position at the left margin.  This is the 
easiest alignment to read. This paragraph is left aligned.  Notice that text at the right margin do 
not necessarily end in the same position. 

Unit 10.4 - Word Processing 1       Page      30



The Commonwealth of Learning          Module 10 – Applied Computer Studies 

Center – All the lines of the paragraph are centered between the left and right margins.  As you 
can imagine, centering the paragraphs of a letter would look rather awkward. This paragraph is 

centered. 

Align Right – All the lines of the paragraph end in the same position at the right margin.  Text 
leaves a jagged edge at the left margin.  This paragraph is right aligned.   

Justify – All the text in the paragraph line up evenly with the left margin and the right margin.  
There are no jagged edges at either margin.  This gives your paragraphs a tidier look.  This 
paragraph is justified. 

Changing the alignment of paragraphs: 

1. Click anywhere in the text you want to align. 

2. Click on the alignment button you want on the Standard toolbar. 

If you want more than one paragraph aligned in the same way, highlight the paragraphs, then 
click on the alignment button you want. 

You can set the alignment for text before you begin.  Make sure the insertion point is positioned 
where you will start entering text, then click the alignment you want.  Until you change the 
alignment, all the paragraphs will align the same way. 
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Activity 12  
 
Aligning Paragraphs 
 

Open a New blank document.  Apply the alignment and formatting indicated. 
 
1. Type the following document. 
 
  

 
COOKING MADE EASY 

 
10 Minute Sweet Chocolate Pie 
 
Ingredients 
 
4 oz sweet chocolate 
2 tablespoons sugar (optional) 
8 oz Cool Whip 
1/3 cup milk 
3 oz cream cheese, softened 
Baked pie crust or packaged Graham cracker crust 
 
Heat chocolate and 2 tablespoons of milk over low heat, stirring
until melted.  Beat sugar into cream cheese.  Add remaining milk
and chocolate mixture.  Blend until smooth.  Fold Cool Whip
into chocolate mixture and blend thoroughly.  Spoon into crust.
Freeze until firm. 
 

Makes 8 servings
.

 

 
2. Correct any spelling errors.  
 
3. Save the document with the filename:  CHOCOLATE PIE RECIPE 
 
4. Print Preview and then print the document. 
 
5. Close the document. 
 

Centred, bold 

Left aligned, bold

Left aligned 

Left aligned,  
underline 

Justify 

Right aligned, italic
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Page Set-up 

Adjusting Margins 

Margins refer to the distance from the edge of the paper to the text.  The default settings are top 
and bottom margins of 2.5 cm   (1 inch) and the left and right margins of 3.17 cm (1.25 inches).  
These defaults can be varied, if they do not suit your needs. 

There are several ways of adjusting margins in Word.  We will look at using the Page Setup 
dialog box.  Click Page Setup on the File menu.  The Page Setup dialog box will appear. 

 

Margins 
tab 

Notice that the Page Setup dialog box has four tabs.  

To adjust the margins in your document: 

1. Ensure the Margins tab is selected. 

2. Set the Top, Bottom, Left and Right margins to your specification. 

Leaving the option in the Apply to field to “Whole document” will ensure that the margi
every page of the document is changes to the new settings. 

3. Click OK to confirm the changes. 
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Paper Size 

You can change the paper size Word displays for you to type into.  The default paper size in 
Word is Letter (8½” x 11”).   Sometimes it is necessary to change the orientation of the paper 
from normal (portrait) to sideways (landscape) to improve the display of a particular document. 
Both of these can be adjusted in the Page Setup dialog box. 

Click Page Setup on the File menu.  The Page Setup dialog box will appear.  Select the Paper 
Size tab.  

 

To change the paper size and orientation: 

1. Click on the down arrow next the Paper Size box.  

2. From the drop down menu, choose the paper size you want to work in. 

3. In the Orientation box, select the orientation you want 

4. Click OK. 

The pages of your document will change to the paper size and/or orientation you selected. 

(Both options do not have to be adjusted at the same time) 
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Activity 13 
 
Setting Paper Size 
 

1. Open the document CHOCOLATE PIE RECIPE. 
 
2. As there is only one section in this document, when the margins and paper size are changed, it 

will apply to the whole document. 
 Change the left margin to 4 cm (1.5”) and the right margin to 3.5 cm (2”). 
 Change the paper size to landscape. 
 
3. Print Preview the document. 
 
4. Print a copy of the document. 
 
5. Save the changes to the document and close the document. 
 

 
 

 

 
 

 
Switching between documents 

It is possible to move between the open Word documents when several are opened at the same 
time.  Let’s look at two methods. 

Keyboard Command - Ctrl+F6 
Press and hold the Ctrl key. Press the F6 key to display the next document in the active window.  
Each time you do this you switch to another open file. 

Window Menu 
At the bottom of the Window menu you will see a list of the files which are currently open.  The 
file in the active window will have a tick beside it.  Simply click on the required filename to 
make that the active document. 
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Activity 14 
 
Switching between open documents 
 

1. Open the documents COMPETENCE, OUTCOME and CHOCOLATE PIE RECIPE.  
 
2. Move between the active documents using the keyboard.  Note the title bar will display the 

active filename. 
 
2. Use the Window option to activate a different file. 
 
3. Close each of the three documents 
 

 
 

 
 

 
Indenting Paragraphs 

You can apply different indent options to your paragraphs by using the indent markers on the 
horizontal ruler.  To use these markers, the ruler must be visible.  If the horizontal ruler is not 
displayed click Ruler on the View menu. 

There are four different indent options you have in Word: 

• Left indent: all the lines of the paragraph are moved in from the left margin. 

 

 

 
Position of the markers for the Left indent.

Example of a paragraph with left indent: 

This paragraph shows left indent.  Note that all the lines of this paragraph start at the 
same position from the left margin, but do not end the same place at the right margin.  
This is the most common type of indent.   

• First line indent: Indents the first line of the paragraph (works just like the Tab key) 

 

Position of the markers for the first line indent.
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Example of a paragraph using first line indent.  Only the first line is indented, and the 
remainder of the paragraph starts at the left margin.  Pressing the Tab key at the beginning of 
the first line of the paragraph produces this result. 

• Hanging indent: Intends the second and remaining lines of a paragraph to the right of the first 
line. 

 

Position of the markers for the hanging indent. 
 

 

This is an example of a paragraph with hanging indent.  The first line is against the left 
margin, and the remaining lines start at the same position under each other.  This is 
sometimes called an outdent. 

• Right indent: Moves text in from the right margin. 

 

Position of the markers for the right indent.  

This is an example of a right indent.  The lines of the paragraph end 
in the same position at the right margin.  This indent is commonly 
used in conjunction with the left indent to produce a dual indent.  

 
 

 

 
 

 
Adjusting Spacing in Paragraphs  

Line spacing 

Sometimes you will need to adjust the vertical distances between lines for your entire document 
or just portions of it.  While Word has a default setting of “single”, the program offers five 
additional options.   

To change the line spacing for existing text: 

1. Select the paragraph(s) you want to change the line spacing for. 

2. Click Format on the Menu bar, then Paragraph. 

The Paragraph dialog box will appear. 

 

Unit 10.4 - Word Processing 1       Page      37



The Commonwealth of Learning          Module 10 – Applied Computer Studies 

 

Spacing Before 
and After 
paragraphs boxes 

Line 
spacing box

3. Click the Indents and Spacing tab. 

4. Click the Line Spacing drop-down list to select the spacing option you want. 

5. If you choose At Least, Exactly or Multiple, enter a number in the At box. 

6. Click OK. 

The line spacing of the paragraph(s) you selected will be changed. 

Below are the keyboard shortcuts for the single, double and 1.5 line spacing options. 
 
Keyboard Single Ctrl + 1 (on the top row of keyboard) 

 Double Ctrl + 2 

 1.5 Ctrl + 5 

Paragraph spacing 

From old habits, typists normally press Enter twice at the end of a paragraph—once to finish the 
paragraph and once for the blank space.   

The Paragraph Spacing feature will automatically space out paragraphs as you type, saving you 
from pressing the extra Enter.  This gives the opportunity of having a precise spacing between 
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paragraphs, rather than being locked into a full line space. This feature will come in handy when 
using bullet points. The items may look better if there is a smaller space between the items and 
not a full blank line.   

To adjust the spacing between paragraphs: 

1. From the Format menu, choose Paragraph. 

2. In the Before and in the After text boxes, type the point size you want before and after your 
paragraphs. 

3. Click OK.  

As you type and press Enter, Word will automatically place the number of points indicated 
before and after your paragraphs. 

 Use counter to nominate the exact point size required 
 between paragraphs. 
 
 
 
 
 
 

 
 
 
 
 

 

 
 

 
Tabs 

Tabs can be used to line up column of information in your document. Tab stops are markers set 
at 1.27 cm (½ inch) intervals across the page.  Word indicates where these default tab stops are 
set on the horizontal ruler. Pressing the Tab key on the keyboard moves the cursor from one tab 
stop to another.   

 

Preset tab stop markers 

Types of Tabs 

Tabs can easily be changed to suit your needs.  Setting the tab involves choosing the type of tab 
stop and the position of the tab stop. 
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Type Symbol Description 

Left  Left edge of text aligns with tab 

Right  Right edge of text aligns with tab 

Centre  Centre of text aligns with tab 

Decimal  Decimal point aligns with tab 

 

Setting Tab Stops using the ruler 

 
 

 
Left Tab  Stopn 

Decimal Tab Stop Right Tab Stop 

Center Tab Stop
 Tab Selection butto

 
The Tab Selection, button available in Print Layout View, allows you to select the type of ta
By default, the tab stop is set to Left Tab. You can click the button to change the tab stop ch
 
Set tab 

• Click the Tab Selection button to display the type of tab stop you want to

• Click the ruler at the position where you want to set the tab stops (all the 
of the new tab are deleted). 

Move tab 

• Click and drag the tab stop on the ruler to change the position of the tab. 

Clear tab 

• Click and drag the tab stop off the ruler to remove the tab. 

Using the Tab Dialog Box  

You may set and clear tabs and set Leaders by using the tab dialog box.  Ens
point is position where you want your tab stops to begin.  If the text is alread
text to be formatted first. 

Select Format, then Tabs.  The Tabs dialog box will appear. 
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• In the Tab Stop Position text box, type the location of the tab stop you want. 

• Under Alignment, choose the type of tab stop you want created. 

• In the Leader control, select a leader (these “lead” a reader’s eyes across the page). 

• When you are done, click the OK button. 

You may use the Tabs dialog to change the position of tabs, or to clear tab. 
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Activity 15 
 
Setting tabs 
 

1. Open a new blank document. 
 
2. Set the following tabs using the ruler bar: 

 left  3 cm  (1.2”) 
 centre  7 cm (2.8”) 
 right 10 cm (4”) 
 decimal 13 cm (5.2”) 

 
3. Enter the following text, tabbing between each column. 
Remember:  Tab so the first item starts at the 3 cm tab. 
 
 
Monday Montreal Canada 125.00 
Tuesday New York USA 150.00 
Wednesday Kingston Jamaica 175.00 
 
4. Enter twice. 
 
5. Use the menu to clear the four previously set tabs. 
 
6. Use the menu to set a right aligned tab on 6” and choose Option 2 (dotted leader) under the 
Leader option. 
 
7. Type the following, tabbing between as follows. 
 
Introduction............................................................................................................................. Page 1 
Goals ....................................................................................................................................... Page 2 
Objectives ............................................................................................................................... Page 3 
 
8. Save your document as Tab Stops. 
 
9. Print a copy of the document. 
 
10. Close the document. 
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Bullet and Numbering 

When writing a list of items, you can put bullets and numbering in front of each point to improve 
the display.  If you begin a list with a number, Word will continue to number the following 
paragraphs when you press Enter.  Likewise, if you type and asterisk (*) at the beginning of a 
paragraph, Word will bullet consecutive paragraphs when you press enter.  Sometimes, this 
automatic numbering and bulleting happens when you do not intend to bullet or number 
paragraphs.  If this is the case, press the Undo button when Word automatically bullets or 
formats and this feature will be turned off. 

To apply bullets or numbering to a list; 

1. Select the paragraphs you want bulleted or numbered. 
2. On the Formatting toolbar, click the Bullets  or Numbering  button to apply the 

formatting you want. 
Bullets or Numbering will be added. 
 
To remove bullets or numbering, select the text, then click on the formatting you want removed. 
Bullets can be also turned on before you type the text. 
 
You can explore the Bullets and Numbering dialog box on your own to select the types of bullets 
or numbers that will display, to set what number you will start at in a list and to further 
customize your bullets and numbers.  To open the Bullets and Numbering dialog box, select 
Format, then Bullets and Numberings.  The Bullets and Numbering dialog box will open. 
 

 

 
 

 
Activity 16 
 
Adding bullets and Numbering 
 

1. Open the Tab Stops document. 
 
2.  Apply bullets to the first three lines (Monday, Tuesday, Wednesday). 
 
3. Apply numbering to the last three lines (Introduction, Goals, Objectives). 
 
4. Save the document under the new name BULLETS 
 
5. Preview and then print the document. 
 
6. Close the document. 
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Section 5 – Editing 
 

 
 
 

 
Editing text 

You will need to select or highlight the required text before making changes.  There are various 
methods of selecting text, which we will discuss.  Practice each method and then you can make a 
choice as to which you prefer to use.  You will probably find you will use a combination of 
methods. 

Moving and copying text 
 
 

When text is moved, the selected text is deleted and placed in the new location.  Copying text 
leaves the selected text in place and moves a copy to the new location.   

When you cut text, it is deleted from the document and copied to the Clipboard.  Copying text 
moves a copy of the selection to the clipboard without removing the original. The Clipboard is a 
part of your computer’s memory and is managed by Windows.  (As the Clipboard is a shared 
function, it is also possible to copy from one software application to another.  This means that 
you could cut/copy text from Word and use it within another Windows application or you can 
copy between documents in Word). Word 2000 has its own Clipboard which will store up to 
twelve items you copied and paste as many of them as you want pasted.  

To move or copy text: 

1. Select the text you want to move or copy. 

2. Click the copy  or cut  button on the Standard toolbar. 

or choose Edit, then Cut or Copy from the menu, 

or right-click the selected text and click on Cut or Copy 

or Ctrl+X to cut or Ctrl+C to copy 

3. Move the insertion point to where you want the text placed. 

4. Click the Paste  button on the Standard toolbar, 

or choose Edit then Paste from the menu,  

or right-click where you want to paste the text and choose Paste from the shortcut menu. 
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or Ctrl+V to paste. 

The cut/copied text will appear in the new location. 
 
 
 
 
 
 
 
 
 

 

 
 

 
Deleting text 

To Delete text from your document: 

1. Select the text you want to delete. 

2. Press the Delete key to remove the text.   

The text will disappear.  The remaining text will move to fill the space. 

Deleting and replacing text:  

1. Select the text to be deleted. 

2. Type the new text. 

The highlighted text is automatically deleted once you start typing. 

Deleting a word 

Highlight the word and press Delete or  

Highlight the word and simply type new text or 

Use keyboard to position the insertion point at the beginning of the word — press Ctrl + Delete. 

 

Deleting a character 

Position the insertion point to the left or right of the character to be deleted.   

Delete — deletes character to the right.   
Backspace — deletes character to the left. 
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Activity 17 
 
Moving and Deleting Text  
 

1. Open the file PLAN TRAINING document your floppy disk.   
 
2. Make the changes on the following page to the document. 
 
3. Make all the headings Arial and the text Times New Roman font. 
 
4. Save the file to the hard disk (drive C) and give it the filename:  PLAN TRAINING 2. 
 
5. Print a copy of the document. 
 
6. Save the document. 
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Activity 17 (cont’d) 

 
Moving and Deleting Text 
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Multi-page documents 

When a document flows over to a second page, it is referred to as a soft page break.  There are 
times when you, as the operator, wish to force a page break at a particular spot.  This is referred 
to as a hard page break. 

Hard page break 

To create a new page, press Ctrl+Enter or click Insert, Break…,  and select Page Break. 

 

Go to function 

To move to a specific page number in a document: 

 

1. Press Ctrl+G or click Edit, th

The Find and Replace dialog box

2. Type the page number in the 

3. Click Close. 

Word will go to the top of the pag
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Go To 
tab
 

Enter page 
number 

box 

en Go To… 

 will appear. 

Enter page number box. 

e indicated. 
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Activity 18 
 
Multi-page documents 
 

Open the file PLAN TRAINING and let’s make a change to the page break in the document. 
 
1. Make the page break at the heading ‘How to Sequence a Training Session’.  (Position the 

insertion point at beginning of the line and press Ctrl+Enter.) 
 
2. Change to Page Layout View and practise moving to the previous and then the next page. 
 
3. Move up and then down one full screen in the document. 
 
4. Use the Go to function (Ctrl+G) to move to page two and then to page one. 
 

 

 

 

 
 

 
Spelling and Grammar Checking 

 

 

We have already looked at checking your spelling and grammar as you type by right-clicking on 
the flagged word or words. Word also allows you to check all the grammar and spelling errors in 
your entire document at once, rather than correcting these errors as you go along. 

To check the spelling and grammar errors in your document: 

1. Click the Spelling and Grammar button  on the Standard tool bar.   
Word searches the program for any possible spelling or grammar errors.   
If an error is found, word will display the Spelling and Grammar dialog box. 
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Enter the 
correct 
spelling 
directly  
here. 
Turn the 
grammar 
checker 
off. 
The Spelling and Grammar dialog box gives you the same options you will find in the Spell It 
pop-up menu.  Additionally, You can choose to Change All the occurrences of the misspelled 
word and enter the correct spelling.   

2. After you have corrected the word, Word continues to check your document for additional 
spelling and grammar errors. 

3. Word will inform you when all the spelling and grammar errors have been checked.  You 
may stop the spelling and grammar checking at any time by clicking on the Cancel button. 
 

 

 
 

 
Activity 19 
 
Checking spelling and grammar. 
 

1. Open the file from the floppy disk entitled SPELL. 
 
2. Spell check the document.  Save the corrected file on Drive A using a new filename 

NEWSPELL. 
 
3. Save the file NEWSPELL on your hard drive. 
  
4. Print a copy of the document. 
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Proofreading a Document 

A spell check program will only flag a word that is not in the program’s dictionary or the custom 
diction.  After spell checking a document, you cannot assume that the file is totally accurate.  If a 
word is spelt correctly but is used incorrectly, the program cannot always identify this.  It is 
always essential to proofread the hard copy before distributing the document. 

Suggestions: 

It is very easy to read what you think is there rather than what is actually there.  Be very careful!  
Practice looking at only five characters at a time as you read through a document.  

Some proofreading hints to follow: 

Check the document Sentence structure 
Punctuation 
Words used in correct context 

 

Placenames, Names Check these individually for correct spelling 
- there nothing worse than receiving a letter 
with your name spelt wrongly 

 

Numbers Check individually 
Get someone to read them to you, if 
possible 

 

Columns of figures Proofread down the columns - in case a 
complete line is omitted 

 

Display Check final layout - never let something go 
out that doesn’t look ‘good’ 
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Activity 20 
 
Proofreading a document 
 

1. Proofread the file we have just spell-checked and printed (NEWSPELL). 
 
 Did you locate it in the fourth paragraph?  That’s right, ‘there’ was spelt correctly but it was 

the wrong usage of the word.  It should have been ‘their’. 
 
2. Correct any errors you find and resave the file. 
 
3. Print a copy of the file. 
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Section 6 – Tables 
 
 

 

 
 

 
Tables 

You will find the table function very useful for neatly presenting columns of text or numbers.  
Using tables gives you more control over the format of the information and tables are easy to 
create and modify. 

Table structure 

Each table consists of rows which run horizontally and columns which run vertically. The boxes 
within the tables are called cells. 

Normal formatting can be applied to any text within a table.  You can type in each cell as you 
would normally do and Word will wrap the text within the cell. 

Creating a table 

There are several ways of creating a table.  Select whichever method you prefer. 

Using the menu option.   
 
To insert a table using the menu option: 
 
1. Place the insertion point where you want the table inserted. 
2. Click Table on the Menu bar, then Insert, Table. The Insert Table dialog box (like below) 

will appear. 
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3. Enter the number of columns and rows you want to appear in the table. 

4. Press OK. 

The table will appear at the insertion point within the document.  Grid lines appear to show the 
outline of the cells.   

Using the toolbar.  You can use the Insert Table button  on the Standard toolbar to create a 
table. 

When you choose the Insert Table button, an empty grid appears (see below). 

 

Hold the left mouse button down and drag over the grid to indicate the number of rows and 
columns you want in the table.  The table will be inserted at the current position of the insertion 
point. 

Moving around a table 

You can click with the mouse or use the arrow keys to move through the text within the cells.  
To move quickly between cells use the following methods.  Pressing the Tab key moves you to 
the next cell in the table, while pressing Shift+Tab moves you to the previous cell in the table. 
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If you want to move to a tab stop within a cell, press Ctrl+Tab. 

If you place the insertion point in the last cell of your table and press the tab key, Word would 
automatically add an additional row to your table. 

Editing a table 

Highlighting rows and columns 

Highlighting Rows.  Position the insertion point in the left margin and click.  To highlight 
several rows, hold the left mouse button and drag down the rows. 

Highlighting Columns.  Position the insertion point level with the top of the required column.  
The mouse pointer will change to a solid black down arrow.  When this appears, click the mouse 
to highlight the column or hold the left mouse button and drag across several columns. 

Formatting text 

Normal formatting methods apply.  If text exists, highlight the text and then apply the formatting 
you want.  Formatting can be added before or after text is entered. 

Column width 

There are several ways of changing the width of columns within tables.  Select whichever 
method you prefer. 

• Using column border.  When you point to a column border, the mouse pointer changes to a 
double-headed arrow.  Click and hold the left mouse button down as you drag left or right to 
adjust the width of the column. 

• Using the Ruler.  Drag the column markers in the ruler to change the column width. 

 

 

• Using the Menu.  To make a column
Column Height and Width.  Enter 
change several columns, highlight th

Adding rows and columns 

Using the Menu.  To add a row or colum
cell that you want to add a new row or c
above or Rows below or Column to the
want the new row to appear above or be
the column to appear to the left or right o

Unit 10.4 - Word Processing 1   
Column markers
 a specific width use the dialog box, click Table, 
the actual measurement desired for the column.  To 
e columns before accessing the menu option. 

n to a table, position the insertion point anywhere in the 
olumn next to.  Click Table, Insert and click Rows 
 left or Column to the right, depending on whether you 

low the cell where the insertion point is or if you want 
f the cell.  A row or column will be added, 
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Deleting rows and columns 

To delete rows or columns you must highlight the required rows or columns before accessing the 
commands below. 

• To delete row(s) - Table, Delete Row 

• To delete column(s) - Table, Delete Column 

Note:  If you highlight a row and then press the Delete key, only the text within the table will be 
deleted.  The actual row or column will still remain. 

Headings 

If a table extends over several pages it is possible to repeat the same heading rows at the top of 
each page for the table. 

Use Table, Heading Rows Repeat to repeat the column headings at the top of each page where 
the table extends.  
 

 

 
 

 
Activity 21 
 
Creating and editing tables 
 

Let’s use the table function to create the following table. 

1. Use a heading—GIVING FEEDBACK 

 Make the heading center in 16 pt and bold.   

2. Make the rest of the document 11 pt. 

3. Create a table with two columns and four rows. 

4. Add lines to the inside and outside of the table. 

5. The text in the first row should be bold and center. 

6. Enter the following text in the table. 
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Activity 21 (cont’d) 
 
Creating and editing tables  
 

 Aspect Hint  

 Feedback Always start on a positive note.  Find something that was successful.  If you 
have something negative to report, blend it with the positive points. 

 

 Esteem Consider how the trainee will feel about themselves after you have given 
them your feedback. 

 

 Does the 
learner 
understand? 

Check the trainee understands what your feedback means by asking them to 
repeat it back to you in their own words. 

 

 Keep it short Don’t overload the trainees with more feedback than they can use.  

 

7. Save the document as FEEDBK. 

8. Spell check the document.  Resave if necessary. 

9. Print the document. 

10. Proofread the printed copy.  

11. Adjust any errors you note and resave the file. 

12. Print another copy of the file if necessary. 

13. Insert another row before the row – Esteem 

 Add the following text. 

  
Confidentiality 

 
Show the trainees that you respect them by 
giving your feedback to each individual in 
private. 
 

 

 
14. Resave the document using the same name. 
 
16. Print another copy of the document. 
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Section 7 – Using Word 2000 Help Feature 
 
 

 
 

 
Help functions 

Word has an on-line help function that enable you to find out how to perform specific tasks. This 
Help is specific to Word and is separate from the Help in Windows.  There are several different 
ways of accessing Help. 

Menu 

1. Click Help, then Microsoft Word Help.  The Office Assistant appears like below. 

 

Related topics will 
display here. 

See more option 

Enter topic/question 
here 

Clippit is the default 
Office Assistant. 

2. Enter the topic you want help with.   

3. Press the Enter key. A list of topics related to your question will display. 

4. Double-click on the topic you want if it is in the list, press the See More option to see 
additional related topics, or enter another topic to continue search. 

When you double-click the topic, a help window will display, giving you the information on how 
to perform the task you want performed.  Close the window when you are done. 
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Toolbar 

Click on the Microsoft Word Help button  on the Standard toolbar and the Office Assistant 
will appear. 

Keyboard  

Another way to get help is to press the F1 key next to the Escape button at the top left of the 
keyboard.  The Office Assistant will appear. 
 

 

 
 

 
Activity 22 
 
Asking for help 
 

Let’s ask for Help for one of the functions we have just covered. 
 
1. Use the menu method first.  Click Help, Contents and Index. Click on the Index tab and then Enter 

the word “headers” (no quotation marks). 

a) When Headers and footers is highlighted, from the list of topics listed, click Formatting 

b) Click on the Display button 

c) Read the Help screen, using scroll bars to move through the text. 

d) Close the Help screen. 

2. Use the toolbar method. Click on the Office Assistant icon. 

a) Look for help on Insert table. 

b) After reading the information, close the Help screen. 
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Worksheets 
 

 

 
 

 
How to approach these worksheets 

These additional worksheets are designed to incorporate all of the functions covered within this 
unit. 

You can decide whether you need to complete them before attempting your assessment.   

The suggested solutions are at the end of these resources. 

If you are having any problems you should revise the relevant section and then try the activity 
again. 

Should you require further assistance, speak with your tutor. 
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Worksheet 1 
 

1. Create the document in the shaded area below. 
 
 Left/Right Margins 3.5 cm (1.5”) 
 Top/Bottom Margins 3 cm (1.2”) 
 Times New Roman Font - 11 point size 
 
2. Save the document as PRACTICE 1 
 
3. Spell check the file and resave. 
 
4. Print Preview the document. 
 
5. Print a copy of the document. 
 
6. Do not close the PRACTICE 1 document. 
 
How to match training needs to training objectives 
 
Often, the analogy of a jigsaw puzzle is used when training outcomes are defined and discussed.  
A jigsaw puzzle is easier to solve if you have some idea of the picture you want to create. 
 
It is the same with a training outcome.  A training outcome is the ‘picture’ of what the learner/s 
should be able to do at the end of the training.  Basically, a training outcome should answer the 
following question: 
 
What will the learner be able to do at the completion of the training? 
 
A needs analysis is performed to identify the gap between actual performance and required 
performance.  Well-designed training outcomes will help to assess whether the gap is being 
closed. 
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Worksheet 2 
 

 
1. Create the following document 
 
 Left/Right Margins 2.5 cm (1”) 
 Top/Bottom Margins 2.5 cm (1”) 
 Times New Roman 12 point size 
 
2. Save the document as TRAINING OUTCOMES 
 
3. Spell check the file and resave. 
 
4. Print Preview the document. 
 
5. Print a copy of the document. 
 

 
 
6. Close the file 
 
 
 

. 
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Worksheet 3 
 

 
1. To use as many of the features of the word processing system as possible prepare a session plan 
for a 10 minute lesson for your area of expertise. 
 
When deciding on the layout to use, refer to the recommendations included in Module 3 Instruction 
Techniques, Unit 3.6 Lesson Planning. 
 
You may find the tables functions useful to improve the display. 
 
2. Save the document – LESSON PLAN 
 
3. Spell check the document. 
 
4. Print Preview. 
 
5. Print a copy. 
 
6. Close the file. 
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Worksheet 4 
 

1. Open the file PRACTICE1 which you created in worksheet 1. 
 
Change the margins to Left/Right Margins 5 cm (2”) 
Top/Bottom Margins 4 cm (1.6”) 
Times Roman Font 12 point size 
 
2. Make the following changes to document. 
 
3. Spell check the file and SAVE it as PRACTICE 2 
 
4. Print Preview the document. 
 
5. Print a copy of the document. 
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Worksheet 5 
 

1. Open the file TRAINING OUTCOMES 
 
Change the margins to Left/Right Margins 5 cm (2”) 
Top/Bottom Margins 4 cm (1.6”) 
Times Roman Font 12 point size 
 
2. Make the following changes to document. 
 
3. Spell check the file and SAVE it as PRACTICE 4 
 
4. Print Preview the document. 
 
5. Print a copy of the document. 
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Worksheet 6 

 
1. Create the following document.  Select appropriate margins, font, borders and shading. 
 
 Direct Indirect Alternative Supplementary  
 process checklists 

 
 
 
 

product checklists process checklists 
simulation 
product checklists 
objective tests 

objective tests 
role-play 
oral questioning 
reports 
references 

 

 
2. Save the document as PRAC6 
 
3. View the document. 
 
4. Spell check the document and proofread. 
 
5. Resave the document (if necessary). 
 
6. Print a copy of the document. 
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Suggested solutions for activities 
 

 

 
 

 
Suggested solutions to the activities in Section 1 - 7 are included on the 
following pages. 

You may find if you have used a different base font or default margins that the line endings may 
vary slightly.  This is acceptable; it is the other functions which must match the solutions. 

Unit 10.4 - Word Processing 1       Page      69



The Commonwealth of Learning          Module 10 – Applied Computer Studies 

 

Activity 2 - refer to page 13 
 
Competence 
 
If we talk about someone being a "competent teacher", we usually mean someone who is 
recognized as being able to do his or her job.  It's that and a bit more.  It also means that we 
recognized that person is able to perform the job to a certain standard. 
 
The idea of competence is one of the most important concepts in competency based training. 
 
COMPETENT PERFORMANCE 
 
Plan activities that will allow you to check the learner can perform demonstrate and apply. 
 
Word   Definition 
 
perform to the required standard 
demonstrate required attitudes 
apply  important pieces of knowledge 
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Activity 10 - refer to page 27 
 
PREPARING A TRAINING SESSION 
 
LEARNING OUTCOMES 
 
First word should be a 'DOING' word 
 
List 
Explain 
Create 
Operate 
Drive 
Cut 
Cook 
 
Remember, it must be an action that can be measured 
 
 
Don't use 
 

learn, know 
be aware of 
understand 
be able to 
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Activity 12 - refer to page 32 
 

COOKING MADE EASY 
 

10 Minute Sweet Chocolate Pie 
 
Ingredients 
 
4 oz sweet chocolate 
2 tablespoons sugar (optional) 
8 oz Cool Whip 
1/3 cup milk 
3 oz cream cheese, softened 
Baked pie crust or packaged Graham cracker crust 
 
Heat chocolate and 2 tablespoons of milk over low heat, stirring until melted.  Beat sugar into 
cream cheese.  Add remaining milk and chocolate mixture.  Blend until smooth.  Fold Cool Whip 
into chocolate mixture and blend thoroughly.  Spoon into crust.  Freeze until firm. 
 

Makes 8 servings
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Activity 13 - refer to page 35 
 

COOKING MADE EASY 
 

10 Minute Sweet Chocolate Pie 
 
Ingredients 
 
4 oz sweet chocolate 
2 tablespoons sugar (optional) 
8 oz Cool Whip 
1/3 cup milk 
3 oz cream cheese, softened 
Baked pie crust or packaged Graham cracker crust 
 
Heat chocolate and 2 tablespoons of milk over low heat, stirring until melted.  Beat sugar into cream cheese.  Add remaining milk and 
chocolate mixture.  Blend until smooth.  Fold Cool Whip into chocolate mixture and blend thoroughly.  Spoon into crust.  Freeze until 
firm. 
 
Makes 8 servings 
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Activity 15 - refer to page 42 

 
 
Monday Montreal Canada 125.00 
Tuesday New York USA 150.00 
Wednesday Kingston Jamaica 175.00 
 
Introduction............................................................................................................................. Page 1 
Goals ....................................................................................................................................... Page 2 
Objectives ............................................................................................................................... Page 3 
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Activity 16 - refer to page 43 

 
 

• Monday Montreal Canada 125.00 
• Tuesday New York USA 150.00 
• Wednesday Kingston Jamaica 175.00 

 
1. Introduction................................................................................................................ Page 1 
2. Goals .......................................................................................................................... Page 2 
3. Objectives .................................................................................................................. Page 3 
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Activity 17 – Refer to page 47 

PLAN TRAINING 

Document Training Session 

There may well be a lot of training occurring on an ad hoc basis.  Training may not be 
formally planned, conducted or document.  However, the approach to training and  
the implications of the training reforms, mean that there is a need to formalize 
workplace training by planning and documenting training. 
 
Part of the preparation for sound training is to plan and document the training 
sessions.  We will now look at how this can be done. 
 
PLAN TRAINING 

 
How to State Outcomes Clearly 

 
Training needs which you have identifies may well be in general terms.  However, 
training outcomes need to be stated to include: 
 
• an action which is observed or measurable; 
• the conditions under which that action must be performed. 
• a standard which that action must reach; 
 
Action words should be precise, and describe the action you want to measure.  For 
example ‘know’ is unsuitable as it does not tell you what trainees need to do to 
demonstrate their competence.  He word ‘explain’, tells you that they must be able 
to tell you how something works or operates.  Other unacceptable words 
commonly used are: understand, be aware of, be able to, believe.  These do not tell 
you what behaviour you are to measure. 
 
Conditions can refer to the location, equipment, materials, and other conditions 
under which the performance will be measured. 
 
How To Sequence A Training Session 

• What do you want to achieve in the session? 
• How will you achieve it – topic and task analysis? 
• What size is the group? 
• Who are the learners? 
• What are their skills levels, knowledge and abilities? 
• Do they have any special needs? 
• What resources are available and/or required? 
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• How much time do you have?  
 
Training should be set out in easily managed logical steps.  To achieve this, you 
may want to under some brainstorming of factors that will be involved. 
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Activity 19 – Refer to page 50 

 
 

RECOGNITION OF PRIOR LEARNING (RPL) 
 
 One aim of competency based training is to make learning meet the needs of 
the individual learner.  To do this, it is necessary to recognize the skills that learners 
already have before coming to college. 
 
MODEL FOR RPL 
 
Phase 1 Application 
Phase 2 Interview 
Phase 3 Challenge test or pre-test 
 
In Phase 1, learners make application to the college and supply information and 
evidence to prove their competence. 
 
Then the learners go to Phase 2 where they are interviewed by the consultant who 
specializes in recognition of prior learning. 
 
The recognition of prior learning model is similar to an exemption system but a lot 
broader because it also takes into account the learner’s life experiences, not just the 
formal education. 
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Activity 21 – Refer to page 56 
 

Aspect Hint 

Feedback Always start on a positive note.  Find something that was 
successful.  If you have something negative to report, blend it with 
the positive points. 

 
Confidentiality 

 
Show the trainees that you respect them by giving your feedback to 
each individual in private. 
 

Esteem Consider how the trainee will feel about themselves after you have 
given them your feedback. 

Does the learner 
understand? 

Check the trainee understands what your feedback means by 
asking them to repeat it back to you in their own words. 

Keep it short Don’t overload the trainees with more feedback than they can use. 
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WORKSHEET SOLUTIONS 
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WORKSHEET 1 Solution 
 
How to match training needs to training objectives 
 
Often, the analogy of a jigsaw puzzle is used when training outcomes are defined 
and discussed.  A jigsaw puzzle is easier to solve if you have some idea of the 
picture you want to create. 
 
It is the same with a training outcome.  A training outcome is the ‘picture’ of what 
the learner/s should be able to do at the end of the training.  Basically, a training 
outcome should answer the following question: 
 
What will the learner be able to do at the completion of the training? 
 
A needs analysis is performed to identify the gap between actual performance and 
required performance.  Well-designed training outcomes will help to assess 
whether the gap is being closed. 
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WORKSHEET 2 Solution 

 
TRAINING OUTCOMES 

 

TYPES OF OUTCOME 

 
Knowledge 

 
• group discussion 
• group or individual exercises 
• lectures 
• case studies 

 
Attitudes and Values 

 
• role plays 
• demonstrations 
• group discussion 

 
Practical Skills 

 
• demonstration 
• practical sessions 
• simulations 
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WORKSHEET 4 Solution 

 
HOW TO MATCH TRAINING NEEDS TO TRAINING OBJECTIVES 

 
Often, the analogy of a jigsaw puzzle is used when people define training outcomes.  A jigsaw puzzle is easier to solve 
if you have some real idea of the picture you want to create.  It is the same with any training outcome.  A training 
outcome is the ‘picture’ of what the learner/s should be able to do at the end of the training.  Basically, a training 
outcome should answer the following question: 
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What will the learner be able to do at the completion of the training? 
 
A training needs analysis is performed to identify the gap between actual performance and required performance.  Well-
designed training outcomes will help to assess whether the gap is being closed. 

 
 
 

(Your name) 
(Today’s date) 
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WORKSHEET 5 Solution 

TRAINING OUTCOMES 

TYPES OF OUTCOME 

 
Attitudes and Values 

 
• role plays 
• demonstrations 
• group discussion  

 

Knowledge 

 
• group discussion 
• group or individual exercises 
• lectures 
• case studies 
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Practical Skills 

 
• demonstration 
• practical sessions 
• simulations 
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WORKSHEET 6 Solution 

 

Direct Indirect Alternative Supplementary 

process checklists product checklists process checklists 

simulation 

product checklists 

objective tests 

objective tests 

role-play 

oral questioning 

reports 

references 
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